
Design Guide: TIDA-010087
100A、2 相デジタル制御バッテリ・テスタのリファレンス・デザイン

概要

このリファレンス・デザインでは、C2000TM マイクロコントロ

ーラ (MCU) と高精度 ADC ADS131M08 を使用して、双

方向のインターリーブ降圧コンバータ電力段の電流と電圧
を正確に制御する方法を紹介します。このデザインは、
C2000 マイコンの高分解能パルス幅変調 (PWM) 生成ペ

リフェラルを活用して、±20mA 未満の電流レギュレーショ

ン誤差と ±1mV の電圧レギュレーション誤差を実現してい

ます。

リソース
TIDA-010087 デザイン・フォルダ

TMS320F280039 プロダクト・フォルダ

ADS131M08、REF35、INA188 プロダクト・フォルダ

OPA2182、LM321LV、TLV9102、UCC27211 プロダクト・フォルダ

CSD17556Q5B、CSD16570Q5B、LMR54410 プロダクト・フォルダ

TPSI3050、TVS0500、TPS7A20 プロダクト・フォルダ

TLV1117、LM2664、TPS736 プロダクト・フォルダ

C2000WARE-DIGITALPOWER-SDK ツール・フォルダ

テキサス・インスツルメンツの TI E2E™ サ
ポート・エキスパートにお問い合わせくださ
い

特長

• 2 相インターリーブ型、600W、双方向降圧電力段

• 100kHz のスイッチング周波数で 15.8 ビットの PWM 
分解能

• 閉ループ制御用の外部デルタ・シグマ ADC
• レギュレーション誤差 ±20mA 未満の定電流充放電

• レギュレーション誤差は ±1mV 未満で、充電と放電の

両方で定電圧モードに対応
• ソフトウェア周波数応答アナライザ (SFRA) および補

償デザイナにより、制御ループを簡単に調整可能
• ユーザー要件に応じた設計の適用を容易にする 

powerSUITE をサポート

アプリケーション

• バッテリ・セル形成とテスト機器

• プログラマブル DC 電源
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1 システムの説明

バッテリ・テスタ装置には、シングル・セル、バッテリ・モジュール、および高電圧バッテリ・パックのテストに使用されるさまざ
まな装置が含まれています。この試験装置は、高精度の電源とデータ収集システムを搭載しており、バッテリの充電と放電
に使用され、セルのさまざまなパラメータを測定します。

図 1-1 に、リチウムイオン・バッテリを簡略化した製造プロセスを示します。最終段である、エンドオブライン・コンディショニ

ングには、セル形成とテストが含まれます。形成はリチウムイオン電池の製造において重要なステップです。形成中、セル
は最初の充電と放電のプロセスを経て、固体電解質界面 (SEI) 層が形成されます。SEI 層の品質は、バッテリ・セルの容

量と信頼性に影響を及ぼします。形成プロセスを制御するために、セルの充電と放電に高精度のプログラマブル電源が
使用されます。これらの電源は、バッテリ形成システムまたはバッテリ・テスタと呼ばれます。バッテリ・テスタに必要な電圧
および電流の精度は、通常、フルスケールの ±0.02%～±0.05% の範囲内です。
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図 1-1. リチウムイオン・バッテリの製造プロセスの簡素化

1.1 主なシステム仕様

パラメータ 仕様

LV ポート – バッテリ・ポート 50mV～6V

HV ポート – バス電圧 12V～15V

最大出力電流 ± 100A

相あたりの最大 DC 電流 ±50A

位相数 2

スイッチング周波数 93.75kHz

電流レギュレーション誤差 ±20mA (0.02% FS) 未満

電圧レギュレーション誤差 ±1mV (0.02% FS) 未満
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2 システム概要

2.1 ブロック図

図 2-1 は、リファレンス・デザインのブロック図です。TMS320F280039 マイコンは、同期整流降圧電力段用の高分解能 

16 ビット PWM を生成し、電流および電圧制御機能を実行します。INA188 計測アンプが電流を検出し、OPA2182 オペ

アンプが電圧を検出します。電流および電圧信号は、外部の ADS131M08 ADC によってデジタル・データに変換されま

す。C2000 オンチップ・ウィンドウ・コンパレータを使用して、過電流保護を実装しています。
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図 2-1. TIDA-010087 のブロック図

2.2 設計上の考慮事項

2.2.1 電流および電圧コントローラ

電流および電圧制御ループのソフトウェア実装を、図 2-2 に示します。電圧ループを電流にカスケード接続することで、

充電モードと放電モードで定電流と定電圧の両方を実現します。バッテリ電圧が定電圧設定 (VSET) から離れている場

合、電圧ループが定電流設定 (ISET) に飽和します。バッテリ電圧が VSET に近い値に達すると、電圧ループが閉じら

れ、ISET が低下して、バッテリ電圧が VSET 制限を超えないようにします。コントローラは充電モードと放電モードの両方

で動作します。充電モードでは、VSET によって最大バッテリ電圧が制限されるため、充電が停止します。放電モードで

は、VSET によって放電が停止する最小バッテリ電圧が制限されます。
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図 2-2. 電流および電圧コントローラ

2.2.2 高分解能 PWM 生成

高分解能を生成するには、高分解能 PWM 出力機能を持つ C2000 を使用しています。高分解能カウンタは 150ps の
タイム・ステップを実行でき、これは 100MHz の CPU クロックの 100kHz PWM 周波数における 16 ビットの分解能に相

当します。さまざまなスイッチング周波数での PWM 分解能を、表 2-1 に示します。

表 2-1. PWM と HRPWM の C2000™ マイコンの分解能

PWM
周波数

通常の分解能 (PWM) 高分解能 PWM
100MHz EPWMCLK

(kHz) ビット % ビット %
20 12.3 0.02 18.1 0

50 11 0.05 16.8 0.001

100 10 0.1 15.8 0.002

150 9.5 0.15 15.2 0.003

200 9 0.2 14.8 0.004

250 8.6 0.25 14.4 0.005

2.3 主な使用製品

2.3.1 TMS320F280039

TMS320F280039 C2000 デバイスを使用して、同期整流降圧電力段を制御します。このデバイスには、8 つの 

HRPWM チャネルと 4 つのバッテリ・テスト・チャネルまたは降圧コンバータを制御するのに十分な 4 つのウィンドウ付きコ

ンパレータが搭載されています。詳細については、『TMS320F28003x リアルタイム・マイクロコントローラ』のデータシート

を参照してください。

2.3.2 ADS131M08

ADS131M08 は 8 チャネルの同時サンプリング、24 ビット、デルタ・シグマ (ΔΣ) アナログ / デジタル・コンバータ (ADC) 
で、± 0.01% の精度と 1kHz のループ帯域幅に十分な最大 32ksps の最大サンプル・レートを使用できます。
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3 ハードウェア、ソフトウェア、テスト要件、テスト結果

3.1 ハードウェア要件

図 3-1 に TIDA-010087 ハードウェアを示します。TIDA-010087 基板を動作させるには F280039C controlCARD 評価

基板 が必要です。

図 3-1. 基板の概要

3.2 ソフトウェア要件

この設計ソフトウェアは、C2000 マイコン向けの DigitalPower ソフトウェア開発キット (SDK) (C2000WARE-
DIGITALPOWER-SDK) で供給され、powerSUITE フレームワーク内でサポートされています。

3.2.1 Code Composer Studio 内でプロジェクトを開く

CCS でプロジェクトを開始するには、次の手順に従います。

1. Code Composer Studio (CCS) 統合開発環境 (IDE) ツール・フォルダから Code Composer Studio をインストール

します。バージョン 12.3 またはそれ以降をお勧めします。

2. C2000WARE-DIGITALPOWER-SDK を次の 2 つのいずれかの方法でインストールします。

a. CCS にアクセスし、[View] → [Resource Explorer] をクリックします。 テキサス・インスツルメンツの Resource 
Explorer 下で C2000WARE-DIGITAL-POWER-SDK にアクセスし、[Install] ボタンをクリックします。

b. C2000Ware Digital Power SDK ツール・フォルダからダウンロードします。

3. インストールが完了したら、CCS を閉じて、新しいワークスペースを開きます。CCS により自動的に powerSUITE が
検出されます。変更を有効にするために CCS を再起動しなければならない場合があります。

注
デフォルトでは、powerSUITE は SDK のインストールと同時にインストールされます。

ファームウェア・プロジェクトは、次のいずれかの方法でインポートできるようになりました。

• Resource Explorer を使用する

1. Resource Explorer の C2000WARE-DIGITAL-POWER-SDK で、[powerSUITE] → [Solution Adapter Tool] 
をクリックします。 

2. [DC-DC] セクションに表示される設計のリストから TIDA-010087 を選択します。
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3. 開発キット・ページが表示されます。プロジェクトを実行するためのアイコンがトップ・バーに表示されます。[Run 
Project] をクリックします。

4. この操作によりプロジェクトがワークスペース環境にインポートされ、GUI が図 3-2 のような設定ページが表示され

ます。
5. この GUI ページが表示されない場合は、C2000WAREDIGITAL-POWER-SDK Resource Explorer の 

powerSUITE 下の FAQ セクションを参照してください。

• ソリューション・フォルダから直接インポートする

1. CCS 内で [Project] → [Import CCS Projects] をクリックし、/solutions/tida_010087/f28003x/ccs にあるソリュー

ション・フォルダを参照して、プロジェクトを直接インポートすることもできます

2. 2 つのプロジェクト仕様が表示されます。1 つは powerSUITE 付きで、もう 1 つは powerSUITE なしです。いず

れかをクリックすると、プロジェクトの自己完結型フォルダが作成され、その中にすべての依存関係が含まれます。
3. powerSUITE のないプロジェクトは、powerSUITE GUI の制限を見つけたお客様、または量産コードから 

powerSUITE を削除したいお客様向けに提供されています。

4. このドキュメントでは powerSUITE プロジェクトについて説明しますが、powerSUITE のないプロジェクトでは、こ

の設計ガイドに記載されている powerSUITE settings.h ファイルの関連する #defines に変更を加えることで、

すべての手順を繰り返すことができます。

Power Stage Diagram

Project Options

SFRA Enable

Launch SFRA and 

Compensation Designer

図 3-2. 設計の powerSUITE ページ
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3.2.2 プロジェクト構造

図 3-3. プロジェクト構造の概要

プロジェクトの一般構造を、図 3-3 に示します。プロジェクトがインポートされると、図 3-4 に示すように CCS 内に Project 
Explorer が表示されます。

注
図 3-4 は F28003x のプロジェクトを示していますが、powerSUITE ページから別のデバイスを選択しても、そ

の構造は同様です。

コア・アルゴリズム・コードで構成されるソリューション別およびデバイスに依存しないファイルは .c/h にあります。

基板別でデバイス別のファイルは _hal.c/h にあります。 このファイルは、ソリューションを実行するデバイス別ドライバで構

成されています。別の変調方式や別のデバイスを使用する場合は、プロジェクト内のデバイス・サポート・ファイルを変更す
るだけでなく、これらのファイルに変更を加えるだけで済みます。

-main.c ファイルは、プロジェクトのメイン・フレームワークで構成されています。このファイルは、システム・フレームワーク

の作成に役立つ基板とソリューション・ファイルへの呼び出し、割り込みサービス・ルーチン (ISR) と低速なバックグラウン

ド・タスクで構成されています。

この設計では、ソリューションは bt2ph です。

powerSUITE ページは、Project Explorer に表示される main.syscfg ファイルをクリックして開くことができます。

powerSUITE ページでは _settings.h ファイルが生成されます。このファイルは、powerSUITE ページで生成されたプロ

ジェクトのコンパイル時に使用する唯一の C 言語を使用したファイルです。プロジェクトが保存されるたびに 

powerSUITE によって変更内容が上書きされるため、このファイルを手動で変更しないでください。_user_settings.h は 

_settings.h に含まれており、ADC マッピングの #defines や GPIO など、powerSUITE ツールの範囲外の設定を保

持するために使用できます。 

_cal.h ファイルは、電流と電圧を測定するためのゲイン値とオフセット値で構成されています。

Kit.json ファイルと solution.js ファイルは、powerSUITE により内部で使用されるため、ユーザーが変更することはできま

せん。 これらのファイルを変更すると、プロジェクトが正常に機能しなくなります。
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ソリューション名は、ソリューションで使用されるすべての変数および定義のモジュール名としても使用されます。したがっ
て、すべての変数および関数呼び出しの先頭には BT2PH 名が付きます (たとえば、BT2PH_userParam_V_I_ch1)。こ

の命名規則により、ユーザーは名前の競合を回避しながら、異なるソリューションを組み合わせることができます。

Project Name

Settings.h file generated by powerSUITE. 

Generated once the project is built

Include File paths for different components 

in the project

Device Support Files, Driverlib

Local Copy of all the libraries are made in 

the project folder to created a fully 

standalone folder

Target Configuration for debugger 

connection

Solution Specific Files with Board Drivers 

for the solution

JSON file generated and used by 

powerSUITE page (Do not Modify)

powerSUITE GUI Page

JSON file generated and used by 

powerSUITE page (Do not Modify)

.js File used by powerSUITE 

(Do not Modify)

図 3-4. BT2PH プロジェクトの [Project Explorer] ビュー

BT2PH プロジェクトは 3 つの ISR (ISR3、ISR4、および ISR7) で構成されています。ISR1、ISR2、ISR5、および ISR6 
は、今後の使用のために予約されています。

降圧コンバータの入力電圧とコンデンサ電圧を検出するには、ISR3 を使用します。ISR3 は、ADCC 変換完了によってト

リガされます。ADCC を使用してコンバータの入力電圧と出力電圧を検出し、DC/DC のソフト・スタートを実装します。

ISR4 は、ADS131M08 の DRDY (データ・レディ) 信号によってトリガされます。外部 ADC は 15.625kHz のサンプル・

レートにプログラムされ、これによって ISR 周波数が設定されます。ISR は、電流および電圧制御ループ機能を実行しま

す。

ISR7 は、SPI 受信 FIFO 割り込みによってトリガされます。ISR を使用して、FIFO レジスタから外部 ADC データを読み

出します。

図 3-5 および 図 3-6 に、ISR3、ISR4、および ISR7 の所要時間を示します。3 つの ISR に要する合計時間は 8μs 未
満です。ISR は、15.625kHz の ISR 周波数の場合、CPU リソースの 12.5% を消費します。
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図 3-5. ISR4 および ISR7 の実行時間測定

図 3-6. ISR4 および ISR3 の実行時間測定
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3.2.3 ソフトウェア・フロー図

bt2ph_hal.c/h,  ads131m0x.h, and bt2ph_cal.h files are necessary to run the bt2ph_main.c and bt2ph.h/c

main()

//Psuedo code

//Setup device, init interrupt, cputimer

//Setup analogpinmux

// Setup internal ADC

//Setup clock for external ADC

//Setup HRPWM for the power stage

//Enable phase shift

//Configure comparators for overcurrent protection

//Setup SFRA

//Setup SPI for external ADC

//Configure external ADC

//Initial variables used in the program

//Enable interrupts

//Configure output relay

//Send the first tranmit bytes for the external ADC

bt2ph-main.c

Background Loop

A1-> BT2PH_updateEnable(..),BT2PH_updateReference()

A1-> BT2PH_SFRA_GUI_RUN_COMMS

A3->BT2PH_updateHrpwmMepScaleFactor();

B1->BT2PH_monitorIoutVout();

B2->BT2PH_SFRA_RUN_BACKGROUND();

B3-> BT2PH_HAL_enableRelay

ISR3

Restore Context 

Return

BT2PH_HAL_storedata_VSENSE()

ISR4

Restore Context 

Return

BT2PH_HAL_ExtAdcSendTxFrame();

BT2PH_runPwmIsr();

ISR7

Restore Context 

Return

BT2PH_HAL_ExtAdcRead();

bt2ph.h

Definition of all global variables for the

solution module

BT2PH_initUserVariables();

…

BT2PH_setControlCoeffcients();

…

BT2PH_setupSfraGui();

…

BT2PH_updateEnable();

BT2PH_updateEnable();

BT2PH_updateReference();

Declaration of all global variables for the

solution module

BT2PH_dcmStartup();

BT2PH_controlCC();

BT2PH_controlCV();

BT2PH_storedataExtAdc();

BT2PH_updateHrpwmMepScaleFactor();

bt2ph.c

Return

BT2PH_storedataExtAdc();

…

BT2PH_controlCC();

….

BT2PH_controlCV();

…

BT2PH_runPwmIsr()

図 3-7. ソフトウェア・フロー図
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3.3 テスト設定

3.3.1 電流および電圧ループをチューニングするためのハードウェア設定

TIDA-010087

V_HV Battery Port

10 m�

(Shorted to GND)
DC Source

(12 V – V)

図 3-8. 電流および電圧ループをチューニングするためのハードウェア設定

3.3.2 双方向の電力フローをテストするためのハードウェア設定

TIDA-010087

DC Source

12 V to 15 V

E-load

CC Mode

DC Source

0 V to 5 V

E-load

CC Mode

12-V Bus Battery Port

図 3-9. 双方向の電力フローをテストするためのハードウェア設定

3.3.3 電流および電圧キャリブレーションのハードウェア設定

TIDA-BOARD

DC Source

12 V to 15 V

E-load

CC Mode

12-V Bus Battery Port

6 ½ Digit DMM

Current Measurement

6 ½ Digit DMM

Voltage Measurement

図 3-10. 電流および電圧キャリブレーションのハードウェア設定
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3.4 テスト方法

3.4.1 ラボ変数の定義

BT2PH_userParam_V_I_chx パラメータは、さまざまなラボで電力段を制御するために使用します。ラボ 1 とラボ 2 で
は、DC/DC コンバータの位相 1 と位相 2 を制御するために、BT2PH_userParam_V_I_ch1 と 

BT2PH_userParam_V_I_ch2 を使用します。ラボ 3 とラボ 4 では、BT2PH_userParam_V_I_chm 変数を使用します。

パラメータの定義については、表 3-1 を参照してください。

表 3-1. BT2PH_userParam 定義

BT2PH_userParam データの種類 備考

iref_A フローティング 充電モードと放電モードの両方の電流を設定 [0、100]

vrefCharge_V フローティング 充電モードで電圧を設定 [0、5]

vrefDischarge_V フローティング 放電モードで電圧を設定 [0、5]

dir_bool 符号なし整数
充電モードの場合、このパラメータを 1 に設定します

放電モードの場合、このパラメータを 0 に設定します

en_bool 符号なし整数
チャネルをイネーブルにする場合、このパラメータを 1 に設定しま

す

dutyRef_pu フローティング 開ループ・モードの基準デューティ・サイクル範囲 = 0～1.0

ibatCal_pu フローティング
キャリブレーション・モードで出力電流を設定するには、このパラメ

ータを使用します。範囲 = 0～1.0

vbatCal_pu フローティング
キャリブレーション・モードで出力電圧を設定するには、このパラメ

ータを使用します。範囲 = 0～1.0

IoutGain_pu フローティング
変数には、電流ゲインのキャリブレーション・データが格納されま

す

ioutOffset_pu フローティング
変数には、現在のオフセットのキャリブレーション・データが格納さ

れます

IoutGain_A フローティング
変数には、電流ゲインのキャリブレーション・データが格納されま

す

IoutOffset_A フローティング
変数には、現在のオフセットのキャリブレーション・データが格納さ

れます

vbatGain_pu フローティング
変数には、電圧ゲインのキャリブレーション・データが格納されま

す

vbatOffset_pu フローティング
変数には、電圧オフセットのキャリブレーション・データが格納され

ます

vbatGain_V フローティング
変数には、電圧ゲインのキャリブレーション・データが格納されま

す

vbatOffset_V フローティング
変数には、電圧オフセットのキャリブレーション・データが格納され

ます

3.4.2 ラボ 1.開ループ電流制御単相

3.4.2.1 ラボ 1 のソフトウェア・オプションの設定

1. セクション 3.2.1 の概要に従って CCS プロジェクトを開きます。powerSUITE を使用している場合は、手順 2 に進み

ます。それ以外の場合は手順 3 に進みます。

2. SYSCONFIG ページを開き、[Build Options] セクションで以下を選択します。

• ラボは [Lab 1:Open Loop CC Single Phase] を選択します。

• [Phase Enabled] を [Phase 1] または [Phase 2] に変更します。

• [SFRA Enable/Disable] を [1] に設定します。

• ページを保存します。

ハードウェア、ソフトウェア、テスト要件、テスト結果 www.ti.com/ja-jp

12 100A、2 相デジタル制御バッテリ・テスタのリファレンス・デザイン JAJU899 – JUNE 2023
Submit Document Feedback

English Document: TIDUF33
Copyright © 2023 Texas Instruments Incorporated

https://www.ti.com/ja-jp
https://www.ti.com/ja-jp/lit/pdf/JAJU899
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU899&partnum=TIDA-010087
https://www.ti.com/lit/pdf/TIDUF33


3. powerSuite のないバージョンのプロジェクトを使用する場合、上記の設定は solution_settings.h ファイルで直接変

更されます。

#define LAB_NUMBER (1)

#define PHASE_NUMBER (1)

#define SFRA_ENABLED (true)

図 3-11. ラボ 1 のビルド・オプション

3.4.2.2 プロジェクトのビルドおよびロードとデバッグ環境の設定

プロジェクトをビルドおよびロードし、デバッグ環境を設定するには、次の手順を実行します。

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。

2. プロジェクトが正常にビルドされます。

3. Project Explorer で、targetConfigs 下で適切な目標構成ファイルが有効になっていることを確認します。

4. 次に、[Run] → [Debug] をクリックしてデバッグ・セッションを起動します。 
5. するとプロジェクトがデバイスにロードされ、CCS デバッグ・ビューが有効になります。メイン・ルーチンの開始時にコー

ドは停止します。
6. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ・ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェク

ト・フォルダ内にある setupdebugenv_lab1_ch1.js スクリプト・ファイルを参照します。 これにより、[Watch] ウィンドウ

に、システムをデバッグするのに必要な適切な変数が入力されます。フェーズ 2 では、setupdebugenv_lab2_ch2.js 
スクリプト・ファイルを選択します。

7. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効に

します。

3.4.2.3 コードの実行

ラボ 1 のコードを実行するには、次の手順に従います。

1. セクション 3.3.1 に示すようにテスト設定を使用します。

2. メニュー・バーの をクリックしてプロジェクトを実行します。
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3. 監視ビューで、[Expression] ウィンドウで BT2PH_InputVoltageSense_V が 12V～15V の範囲内にあるかどうかを

確認します。

4. オシロスコープを使用して、周波数が 15.625kHz の場合に外部 ADC の DRDY 信号をチェックします。 マイコンが

動作しているときの ADS131M08 の DRDY および CS 信号を、図 3-12 に示します。

5. [Expression] ウィンドウで次のパラメータを設定します。

• BT2PH_userParam_V_I_ch1->dutyRef_pu = 0.03
• BT2PH_userParam_V_I_ch1->en_bool = 1 を設定します

• 「BT2PH_enableRelay_bool」を 1 に設定して、出力リレーをイネーブルにします

• [Expression] ウィンドウの設定については、図 3-13 を参照してください

6. BT2PH_measureMultiphere_V_I 変数は、DC/DC コンバータの出力電流と電圧を示します。

BT2PH_userParam_V_I_ch1->dutyRef_pu を調整し、電流が約 15A であることを確認します。

7. 開ループ電流制御用の SFRA 設定 に、開ループ電流制御用のプラント・モデルを抽出するための SFRA 設定を示

します。SYSCONFIG ページで Run SFRA アイコンをクリックします。SFRA GUI がポップアップ表示されます。

8. SFRA GUI でデバイスのオプションを選択します。たとえば、F280039 の場合は浮動小数点を選択します。[Setup 
Connection] をクリックします。ポップアップ・ウィンドウで [Boot on Connect] オプションのチェックを外し、適切な 

COM ポートを選択します。[OK] ボタンをクリックします。SFRA GUI に戻り、[Connect] ボタンをクリックします。

9. SFRA GUI がデバイスに接続します。これで [Start Sweep] をクリックして、SFRA 掃引を開始できるようになりまし

た。SFRA 掃引が完了するまでには数分かかります。完了すると、図 3-15 に示すように測定値が表示されたグラフが

表示されます。
10. また、周波数応答データは SFRA データ・フォルダ下のプロジェクト・フォルダに保存され、SFRA 実行時のタイムス

タンプが記録されます。

図 3-12. 外部 ADC の CSn 信号と DRDY 信号
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図 3-13. ラボ 1 [Expression] ウィンドウ、開ループ

Small Duty 

Cycle 2% to 4%

GND

Synchronous Buck

Plant
SFRA Inject Duty

SFRA Collect

S
h
o
rt

ADCIout

図 3-14. 開ループ電流制御用の SFRA 設定
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図 3-15. 電流制御の開ループ周波数応答

3.4.3 ラボ 2.閉ループ電流制御単相

3.4.3.1 ラボ 2 のソフトウェア・オプションの設定

1. このラボを実行するには、前のセクション、セクション 3.4.2 で説明したようにハードウェアが設定されていることを確認

します。
2. セクション 3.2.1 の概要に従って CCS プロジェクトを開きます。powerSUITE を使用している場合は、手順 3 に進み

ます。それ以外の場合は手順 4 に進みます。

3. SYSCONFIG ページを開き、[Build Options] セクションで以下を選択します。

• ラボは [Lab 2:Closed Loop CC Single Phase] を選択します。

• [Phase Enabled] を [Phase 1] または [Phase 2] に変更します。

• [SFRA Enable/Disable] を [1] に設定します。

• [Run Compensation Design] ボタンをクリックして、Compensation Designer  を開きます。

• 補償デザイナが起動し、有効な SFRA データ・ファイルを選択するように求められます。ラボ 1 の実行から補償デ

ザイナに SFRA データをインポートし、2 極、2 ゼロの補償器を設計します。この設計の繰り返し中により多くのマ

ージンを確保して、ループが閉じたときにシステムが安定するようにします。
• 電流ループの補償パラメータを、図 3-16 に示します。

• [Save Comp] ボタンをクリックして、補償を保存します。Compensation Designer ツールを閉じます。

• SYSCONFIG ページを保存します。

4. powerSUITE 以外のバージョンのプロジェクトを使用する場合、[Build Settings] は solution_settings.h ファイルで

直接変更されます。 Compensation Designer は、

C2000Ware_DigitalPower_Install_Location\powerSUITE\source\utils に配置されています。

#define LAB_NUMBER (2)

#define PHASE_NUMBER (1)

#define SFRA_ENABLED (true)
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図 3-16. Compensation Designer を使用した電流ループのチューニング

3.4.3.2 プロジェクトのビルドおよびロードとデバッグ環境の設定

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。

2. プロジェクトが正常にビルドされます。

3. Project Explorer で、targetConfigs 下で適切な目標構成ファイルが有効になっていることを確認します。

4. 次に、[Run] → [Debug] をクリックしてデバッグ・セッションを起動します。 
5. するとプロジェクトがデバイスにロードされ、CCS デバッグ・ビューが有効になります。メイン・ルーチンの開始時にコー

ドは停止します。
6. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ・ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェク

ト・フォルダ内にある setupdebugenv_lab2_ch1.js スクリプト・ファイルを参照します。 これにより、[Watch] ウィンドウ

に、システムをデバッグするのに必要な適切な変数が入力されます。フェーズ 2 では、setupdebugenv_lab2_ch2.js 
スクリプト・ファイルを選択します。

7. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効に

します。

3.4.3.3 コードの実行

1. このラボを実行するには、前のセクション、セクション 3.4.2 で説明したようにハードウェアが設定されていることを確認

します。

2. メニュー・バーの をクリックしてプロジェクトを実行します。

3. 監視ビューで、[Expression] ウィンドウで BT2PH_InputVoltageSense_V が 12V～15V の範囲内にあるかどうかを

確認します。

4. [Expression] ウィンドウで次のパラメータを設定します。

• BT2PH_enableRelay_bool を 1 に設定して、出力リレーをイネーブルにします。

• BT2PH_userParam_V_I_ch1->iref_A = 15.0。

• BT2PH_userParam_V_I_ch1->en_bool = 1 を設定します。
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• [Expression] ウィンドウの設定については、図 3-17 を参照してください。

5. BT2PH_measureMultiphere_V_I 変数は、DC/DC コンバータの出力電流と電圧を示します。Isense1_A の表示値

は iref_A 設定に近く、誤差は ±1mA です。

6. ループ安定性をテストするための SFRA を 図 3-18 に示します。SYSCONFIG ページで Run SFRA アイコンをクリ

ックします。 SFRA GUI がポップアップ表示されます。

7. SFRA GUI でデバイスのオプションを選択します。たとえば、F280039 の場合は浮動小数点を選択します。[Setup 
Connection] をクリックします。ポップアップ・ウィンドウで [Boot on Connect] オプションのチェックを外し、適切な 

COM ポートを選択します。[OK] をクリックします。SFRA GUI に戻り、[Connect] ボタンをクリックします。

8. SFRA GUI がデバイスに接続します。これで [Start Sweep] をクリックして、SFRA 掃引を開始できるようになりまし

た。SFRA 掃引が完了するまでには数分かかります。完了すると、図 3-19 に示すように測定値が表示されたグラフが

表示されます。
9. また、周波数応答データは SFRA データ・フォルダ下のプロジェクト・フォルダに保存され、SFRA 実行時のタイムス

タンプが記録されます。

図 3-17. ラボ 2 [Expression] ウィンドウ、閉ループ
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図 3-18. 閉ループ電流制御の SFRA 設定

図 3-19. 電流制御の閉ループ周波数応答

3.4.3.4 電流キャリブレーション

1. このラボを実行するには、セクション 3.3.3 で説明したようにハードウェアが設定されていることを確認します。ゲイン誤

差とオフセット誤差のキャリブレーションには、2 点較正法を使用します。

2. 電流を測定するには、外付けの高精度抵抗と DMM を使用するか、E-Load 電流測定値を使用します。または、

TIDA-010087 基板上のセンス抵抗の両端の電圧を使用して、出力電流を測定できます。

3. SYSCONFIG ページを開き、[Build Options] セクションで以下を選択します。

• ラボは [Lab 2:Closed Loop CC Single Phase] を選択します。

• [Phase Enabled] を [Phase 1] に変更します。

• 電流キャリブレーションは [Calibration Mode] を [1] に設定します。

• SYSCONFIG ページを保存し、コードを実行します。

• [Expression] ウィンドウを開きます。

• 出力電流は、BT2PH_userParam_V_I_ch1->ibatCal_pu パラメータを使用して更新します。

• BT2PH_enableRelay_bool を 1 に設定して、出力リレーをイネーブルにします。

• BT2PH_userParam_V_I_ch1->en_bool = 1 を設定します。

• BT2PH_userParam_V_I_ch1->ibatCal_pu を「0.05」および「0.3」に設定し、出力電流読み取り値を書き留めま

す。
• bt2ph_cal.h ファイルの実際の出力電流読み取り値を更新します。
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#define BT2PH_IBAT_ACTUAL_CH1_P1_A ((float32_t)2.6556)

#define BT2PH_IBAT_ACTUAL_CH1_P2_A ((float32_t)16.163)

#define BT2PH_IBAT_ACTUAL_CH2_P1_A ((float32_t)2.6556)

#define BT2PH_IBAT_ACTUAL_CH2_P2_A ((float32_t)16.163)

• コンバータのフェーズ 2 についても、この手順を繰り返します。

• キャリブレーションをディセーブルにするには [Calibration Mode] を [0] に設定します。

4. powerSUITE 以外のバージョンのプロジェクトを使用する場合、[Build Settings] は solution_settings.h ファイルで

直接変更されます。 

#define LAB_NUMBER (2)

#define PHASE_NUMBER (1)

#define CALIBRATION_ENABLED (true)

#define CALIBRATION_MODE (1)

図 3-20. 電流キャリブレーションのビルド・オプション

3.4.4 ラボ 3.閉ループ電流制御 2 相

3.4.4.1 ラボ 3 のソフトウェア・オプションの設定

1. セクション 3.3.1 に示すようにテスト設定を使用します。

2. セクション 3.2.1 の概要に従って CCS プロジェクトを開きます。powerSUITE を使用している場合は、手順 3 に進み

ます。それ以外の場合は手順 4 に進みます。

3. SYSCONFIG ページを開き、[Build Options] セクションで以下を選択します。

• ラボは [Lab 3:Closed-Loop CC Dual Phase] を選択します。

• 2 相モードは [Phase Enabled] を [0] に変更します。

• [SFRA Enable/Disable] を [1] に設定します。
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• ページを保存します。

4. powerSUITE 以外のバージョンのプロジェクトを使用する場合、上記の設定は solution_settings.h ファイルで直接

変更されます。

#define LAB_NUMBER (3)

#define PHASE_NUMBER (0)

#define SFRA_ENABLED (true)

3.4.4.2 プロジェクトのビルドおよびロードとデバッグ環境の設定

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。

2. プロジェクトが正常にビルドされます。

3. Project Explorer で、targetConfigs 下で適切な目標構成ファイルが有効になっていることを確認します。

4. 次に、[Run] → [Debug] をクリックしてデバッグ・セッションを起動します。 
5. するとプロジェクトがデバイスにロードされ、CCS デバッグ・ビューが有効になります。メイン・ルーチンの開始時にコー

ドは停止します。
6. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ・ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェク

ト・フォルダ内にある setupdebugenv_lab3.js スクリプト・ファイルを参照します。 これにより、[Watch] ウィンドウに、シ

ステムをデバッグするのに必要な適切な変数が入力されます。

7. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効に

します。

3.4.4.3 コードの実行

1. セクション 3.3.1 に示すようにテスト設定を使用します。

2. メニュー・バーの をクリックしてプロジェクトを実行します。

3. 監視ビューで、[Expression] ウィンドウで BT2PH_InputVoltageSense_V が 12V～15V の範囲内にあるかどうかを

確認します。

4. [Expression] ウィンドウで次のパラメータを設定します。

• BT2PH_enableRelay_bool を 1 に設定して、出力リレーをイネーブルにします。

• BT2PH_userParam_V_I_chm->iref_A = 15.0。

• BT2PH_userParam_V_I_ch1->en_bool = 1 を設定します。

• [Expression] ウィンドウの設定については、図 3-21 を参照してください。

5. BT2PH_measureMultiphere_V_I 変数は、DC/DC コンバータの出力電流と電圧を示します。Ibatsense_A の表示

値は iref_A 設定に近く、誤差は ±1mA です。

6. 図 3-22 に、開ループ電圧制御周波数応答を測定するための SFRA 設定を示します。

7. SYSCONFIG ページで Run SFRA アイコンをクリックします。 SFRA GUI がポップアップ表示されます。

8. SFRA GUI でデバイスのオプションを選択します。たとえば、F280039 の場合は浮動小数点を選択します。[Setup 
Connection] ボタンをクリックします。ポップアップ・ウィンドウで [Boot on Connect] オプションのチェックを外し、適切

な COM ポートを選択します。[OK] をクリックします。SFRA GUI に戻り、[Connect] ボタンをクリックします。

9. SFRA GUI がデバイスに接続します。これで [Start Sweep] ボタンをクリックして、SFRA 掃引を開始できるようになり

ました。SFRA 掃引が完了するまでには数分かかります。完了すると、図 3-23 に示すように測定値が表示されたグラ

フが表示されます。
10. また、周波数応答データは SFRA データ・フォルダ下のプロジェクト・フォルダに保存され、SFRA 実行時のタイムス

タンプが記録されます。
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図 3-21. ラボ 3 [Expression] ウィンドウ、閉ループ
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図 3-22. 開ループ電流制御の SFRA 設定
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図 3-23. 電圧制御の開ループ周波数応答

3.4.5 ラボ 4.閉ループ電流および電圧制御

3.4.5.1 ラボ 4 のソフトウェア・オプションの設定

1. セクション 3.3.1 に示すようにテスト設定を使用します。

2. セクション 3.2.1 の概要に従って CCS プロジェクトを開きます。powerSUITE を使用している場合は、手順 3 に進み

ます。それ以外の場合は手順 4 に進みます。

3. SYSCONFIG ページを開き、[Build Options] セクションで以下を選択します。

• ラボは [Lab 4:Closed-Loop CCCV Dual Phase] を選択します。

• 2 相動作は [Phase Enabled] を [0] に変更します。

• [SFRA Enable/Disable] を [1] に設定します。

• [Run Compensation Design] ボタンをクリックして、Compensation Designer  を開きます。

• 補償デザイナが起動し、有効な SFRA データ・ファイルを選択するように求められます。ラボ 1 の実行から補償デ

ザイナに SFRA データをインポートし、2 極、2 ゼロの補償器を設計します。この設計の繰り返し中により多くのマ

ージンを確保して、ループが閉じたときにシステムが安定するようにします。
• 電圧ループの補償パラメータを、図 3-24 に示します。

• [Save Comp] ボタンをクリックして、補償を保存します。Compensation Designer ツールを閉じます。

• SYSCONFIG ページを保存します。

4. powerSuite のないバージョンのプロジェクトを使用する場合、[Build Settings] は solution_settings.h ファイルで直

接変更されます。 Compensation Designer は、

C2000Ware_DigitalPower_Install_Location\powerSUITE\source\utils に配置されています

#define LAB_NUMBER (4)

#define PHASE_NUMBER (0)

#define SFRA_ENABLED (true)
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図 3-24. Compensation Designer を使用した電圧ループのチューニング

3.4.5.2 プロジェクトのビルドおよびロードとデバッグ環境の設定

1. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。

2. プロジェクトが正常にビルドされます。

3. Project Explorer で、targetConfigs 下で適切な目標構成ファイルが有効になっていることを確認します。

4. 次に、[Run] → [Debug] をクリックしてデバッグ・セッションを起動します。 
5. するとプロジェクトがデバイスにロードされ、CCS デバッグ・ビューが有効になります。メイン・ルーチンの開始時にコー

ドは停止します。
6. [Watch] および [Expressions] ウィンドウに変数を追加するには、[View] → [Scripting Console] をクリックして、

[Scripting Console] ダイアログ・ボックスを開きます。 このコンソールの右上隅で、[Open] をクリックして、プロジェク

ト・フォルダ内にある setupdebugenv_lab4.js スクリプト・ファイルを参照します。 これにより、[Watch] ウィンドウに、シ

ステムをデバッグするのに必要な適切な変数が入力されます。

7. [Watch] ウィンドウで [Continuous Refresh] ボタン ( ) をクリックして、コントローラからの値の連続更新を有効に

します。

3.4.5.3 コードの実行

1. セクション 3.3.1 に示すようにテスト設定を使用します。

2. メニュー・バーの をクリックしてプロジェクトを実行します。

3. 監視ビューで、[Expression] ウィンドウで BT2PH_InputVoltageSense_V が 12V～15V の範囲内にあるかどうかを

確認します。

4. [Expression] ウィンドウで次のパラメータを設定します。

• BT2PH_enableRelay_bool を 1 に設定して、出力リレーをイネーブルにします。

• BT2PH_userParam_V_I_chm->iref_A = 30.0。

• BT2PH_userParam_V_I_chm->vrefCharge_V = 0.12。

• BT2PH_userParam_V_I_ch1->en_bool = 1 を設定します。

• [Expression] ウィンドウの設定については、図 3-25 を参照してください。
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5. BT2PH_measureMultiphere_V_I 変数は、DC/DC コンバータの出力電流と電圧を示します。Vbatsense_V の表

示値が vrefCharge_V に近く、誤差は ±0.5mV です。

6. 図 3-26 に、閉ループ電圧制御周波数応答を測定するための SFRA 設定を示します。

7. SYSCONFIG ページで Run SFRA アイコンをクリックします。 SFRA GUI がポップアップ表示されます。

8. SFRA GUI でデバイスのオプションを選択します。たとえば、F280039 の場合は浮動小数点を選択します。[Setup 
Connection] ボタンをクリックします。ポップアップ・ウィンドウで [Boot on Connect] オプションのチェックを外し、適切

な COM ポートを選択します。[OK] をクリックします。SFRA GUI に戻り、[Connect] ボタンをクリックします。

9. SFRA GUI がデバイスに接続します。これで [Start Sweep] ボタンをクリックして、SFRA 掃引を開始できるようになり

ました。SFRA 掃引が完了するまでには数分かかります。完了すると、図 3-27 に示すように測定値が表示されたグラ

フが表示されます。
10. また、周波数応答データは SFRA データ・フォルダ下のプロジェクト・フォルダに保存され、SFRA 実行時のタイムス

タンプが記録されます。

図 3-25. ラボ 4 [Expression] ウィンドウ、閉ループ
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図 3-26. 閉ループ電流制御の SFRA 設定

図 3-27. 電圧制御の閉ループ周波数応答

3.4.5.4 電圧キャリブレーション

1. このラボを実行するには、セクション 3.3.3 で説明したようにハードウェアが設定されていることを確認します。キャリブ

レーション中に E-Load をオフにすることができますが、そうでない場合、E-Load 電流設定を iref_A より小さい値に

設定して回路を定電圧モードにします。ゲイン誤差とオフセット誤差のキャリブレーションには、2 点キャリブレーション

法を使用します。
2. 電圧を測定するには、DMM を使用します。

3. SYSCONFIG ページを開き、[Build Options] セクションで以下を選択します。

• ラボは [Lab 4:Closed-Loop CCCV Dual Phase] を選択します。

• 2 相モードは [Phase Enabled] を [0] に変更します。

• 電圧キャリブレーションは [Calibration Mode] を [2] に設定します。

• SYSCONFIG ページを保存し、コードを実行します。

• [Expression] ウィンドウを開きます。

• 出力電流は、BT2PH_userParam_V_I_chm->ibatCal_pu パラメータを使用して更新します。

• BT2PH_enableRelay_bool を 1 に設定して、出力リレーをイネーブルにします。

• BT2PH_userParam_V_I_chm->en_bool = 1 を設定します。

• BT2PH_userParam_V_I_chm->vbatCal_pu を「0.2」および「0.6」に設定し、出力電圧読み取り値を書き留めま

す。
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• bt2ph_cal.h ファイルの実際の出力電圧読み取り値を更新します。

#define BT2PH_VBAT_ACTUAL_CH1_P1_V ((float32_t)1.1995)

#define BT2PH_VBAT_ACTUAL_CH1_P2_V ((float32_t)3.599)

• キャリブレーションをディセーブルにするには [Calibration Mode] を [0] に設定します。

4. powerSuite のないバージョンのプロジェクトを使用する場合、[Build Settings] は solution_settings.h ファイルで直

接変更されます。 

#define LAB_NUMBER (4)

#define PHASE_NUMBER (0)

#define CALIBRATION_ENABLED (true)

#define CALIBRATION_MODE (2)

図 3-28. 電流キャリブレーションのビルド・オプション

3.5 テスト結果

3.5.1 電流ループ負荷レギュレーション誤差

表 3-2. 充電モードでの電流ループ負荷レギュレーション誤差

FSR (A) 100
TIDA_010087
ISET (A) 0.1 0.5 1 5 10 20 25 30 39

ELOAD CV モード E-LOAD 読み取り

VSET (V) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A) Iactual (A)
1 0.118 0.516 1.015 5.011 10.006 19.996 25.004 30.006 39.009

2 0.117 0.514 1.015 5.012 10.009 20.004 25.003 30.005 39.006

3 0.115 0.513 1.012 5.01 10.007 20.003 25.002 30.003 39.004
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表 3-2. 充電モードでの電流ループ負荷レギュレーション誤差 (continued)
4.2 0.112 0.51 1.01 5.008 10.005 20.001 25 30.001 39.001

誤差 (mA) 0.018 0.016 0.015 0.012 0.009 0.004 0.004 0.006 0.009

誤差 (% FSR) 0.018 0.016 0.015 0.012 0.009 0.004 0.004 0.006 0.009

3.5.2 電圧ループ負荷レギュレーション誤差

表 3-3. 充電モードでの電圧ループ負荷レギュレーション誤差

フルスケール値 (V) 6.25

TIDA_010087 VSET (V) 1 2 3 4.2

ELOAD CC モード

ISET (A) Vactual (V) Vactual (V) Vactual (V) Vactual (V)

1 1.00012 2.00038 3.0002 4.2

10 1.00013 2.00039 3.00022 4.20002

20 1.00018 2.00035 3.00018 4.2

30 1.00012 2.00037 3.0002 4.19998

誤差 (mV) 0.00018 0.00039 0.00022 2E-05

誤差 (% FSR) 0.00288 0.00624 0.00352 0.00032

3.5.3 無負荷時の電圧遷移

図 3-29. 無負荷時の電圧遷移
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3.5.4 スタートアップ時の過渡応答

図 3-30. スタートアップ時の過渡応答

3.5.5 双方向電流スイッチング時間

図 3-31. 電流遷移、充電モードから放電モードへ
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図 3-32. 電流遷移、放電モードから充電モードへ
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4 設計とドキュメントのサポート

4.1 設計ファイル

4.1.1 回路図

回路図をダウンロードするには、TIDA-010087 の設計ファイルを参照してください。

4.1.2 BOM

部品表 (BOM) をダウンロードするには、TIDA-010087 の設計ファイルを参照してください。

4.2 ツールとソフトウェア

ツール

TMDSCNCD280039C F280039C controlCARD 評価基板

ソフトウェア

CCSTUDIO Code Composer Studio (CCS) 統合開発環境 (IDE)
C2000WARE-DIGITALPOWER-SDK C2000™ マイコン向け DigitalPower ソフトウェア開発キット (SDK)

4.3 ドキュメントのサポート

1. テキサス・インスツルメンツ、『TMS320F28003x リアルタイム・マイクロコントローラ』データシート

2. テキサス・インスツルメンツ、『ADS131M08 8 チャネル、同時サンプリング、24 ビット、デルタ・シグマ ADC』データシ

ート

4.4 サポート・リソース

TI E2E™ サポート ・フォーラムは、エンジニアが検証済みの回答と設計に関するヒントをエキスパートから迅速かつ直接

得ることができる場所です。既存の回答を検索したり、独自の質問をしたりすることで、設計で必要な支援を迅速に得るこ
とができます。

リンクされているコンテンツは、該当する貢献者により、現状のまま提供されるものです。これらは TI の仕様を構成するも

のではなく、必ずしも TI の見解を反映したものではありません。TI の使用条件を参照してください。

4.5 商標
TI E2E™ and C2000™ are trademarks of Texas Instruments.
すべての商標は、それぞれの所有者に帰属します。

5 著者

SHAURY ANAND は、テキサス・インスツルメンツのシステム・エンジニアであり、テストおよび測定アプリケーションのリフ

ァレンス・デザイン開発を担当しています。インド工科大学ローキー校で電気工学の学士号 (B.Tech) を取得しています。

著者は、このリファレンス・デザインでいただいたサポートに対して、VICTOR SALOMON と OZINO ODHARO に感謝し

ています。
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重要なお知らせと免責事項
TI は、技術データと信頼性データ (データシートを含みます)、設計リソース (リファレンス・デザインを含みます)、アプリケーションや
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